
GigaVUE-FM 
 Installation and Upgrade Guide 

Version 5.7.00



COPYRIGHT
Copyright © 2019 Gigamon Inc. All Rights Reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any 
language in any form or by any means without Gigamon’s written permission.

TRADEMARK ATTRIBUTIONS
Copyright © 2019 Gigamon Inc. All rights reserved. Gigamon and the Gigamon logo are 
trademarks of Gigamon in the United States and/or other countries. Gigamon trademarks 
can be found at www.gigamon.com/legal-trademarks. All other trademarks are the 
trademarks of their respective owners.

DOCUMENT REVISION – 8/11/19

http://www.gigamon.com/legal-trademarks


Contents
1 GigaVUE-FM Installation and Upgrade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

2 Install GigaVUE-FM on VMware ESXi  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Before You Install. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Prerequisites for GigaVUE-FM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
VMware ESXi and NSX-V Hardware Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Supported Browsers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Install New GigaVUE-FM on VMware ESXi . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Upgrades and OVA Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Deploy GigaVUE-FM from an OVA File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Redeploy GigaVUE-FM Instance (with VMs Already Deployed) . . . . . . . . . . . . . . . . . . . . . .  19
Initial GigaVUE-FM Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Use Fault Tolerance for GigaVUE-FM Deployments (VMware ESXi only)  . . . . . . . . . .  19
Perform Initial Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Add Additional vNIC  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Increase the Memory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
Add vCPUs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Configure SSH Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
HTTP/HTTPS Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29
Install Third-Party Certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  29

Install Third-Party Certificate on GigaVUE-FM in AWS. . . . . . . . . . . . . . . . . . . . .  30

3 Install GigaVUE-FM on MS Hyper-V . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Windows Server Hardware Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Supported Browsers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Install GigaVUE-FM for Microsoft Hyper-V  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
Install GigaVUE-FM from an ISO Image File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Connect and Power On the GigaVUE-FM Virtual Machine. . . . . . . . . . . . . . . . . .  41
Initial GigaVUE-FM Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
Configure SSH Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
HTTP/HTTPS Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45

4 Install GigaVUE-FM on KVM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Linux Server Hardware Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
GigaVUE-FM Installation and Upgrade Guide  3



Supported Browsers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
Install GigaVUE-FM for KVM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Install GigaVUE-FM from an ISO Image File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49
Initial GigaVUE-FM Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54
Configure SSH Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
HTTP/HTTPS Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

5 Upgrade GigaVUE-FM . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
Upgrade an Existing GigaVUE-FM Deployment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Upgrade from CLI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
CLI Summary of the Upgrade Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Upgrade from GigaVUE-FM UI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Upgrade from External Image Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Upgrade with GigaVUE-FM as the Image Server . . . . . . . . . . . . . . . . . . . . . . . . .  65

How to Use the Snapshot Feature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

6 Additional Sources of Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Documentation Feedback  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
Contacting Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
Contacting Sales  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71

Premium Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
The Gigamon Community  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
4 GigaVUE-FM Installation and Upgrade Guide 



 

1 GigaVUE-FM Installation and Upgrade
This guide describes how to install the GigaVUE® Fabric Manager 
(GigaVUE-FM) on ESX, MS HyperV, and KVM. Upgrade information is also 
provided. Refer to the following sections for details:

• Install GigaVUE-FM on VMware ESXi on page 7

• Install GigaVUE-FM on MS Hyper-V on page 31

• Install GigaVUE-FM on KVM on page 47

• Upgrade GigaVUE-FM on page 59
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2 Install GigaVUE-FM on VMware ESXi
This section describes how to install GigaVUE-FM on VMware hypervisor, 
ESXi. It consists of the following main sections:

• Before You Install on page 7 describes the minimum hardware and 
computing requirements.

• Install New GigaVUE-FM on VMware ESXi on page 9 describes the steps 
to install and deploy GigaVUE-FM on VMware ESXi hypervisor.

• Configure SSH Settings on page 28 describes the CLI for setting SSH.

• HTTP/HTTPS Ports on page 29 describes the CLI for setting the Web 
access.

Before You Install
This section describes the hardware and virtual computing requirements for 
GigaVUE-FM. Ensure that the GigaVUE-FM time is set correctly to ensure 
accuracy of the trending data that is captured.

Prerequisites for GigaVUE-FM
Before Installing GigaVUE-FM, ensure that VMware vSphere Standard, 
Enterprise, or Enterprise Plus is installed on hardware that meets minimum 
requirements. The following VMware vSphere versions are supported. Note 
the minimum version requirements under Hardware Requirements on 
page 7.

VMware ESXi and NSX-V Hardware Requirements
The following table describes the hardware requirements on which VMware 
ESXi runs GigaVUE-FM.

Table 2-1:  Hardware Requirements for VMware Hypervisor

 Hardware Requirements

VMware Hypervisor vSphere ESXi: v5.5 and above.
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The following table lists the virtual computing resources for GigaVUE-FM.

Supported Browsers 
GigaVUE-FM has been tested on the following browsers:

Notes:

• Only the browsers that support TLS v1.2 can access GigaVUE-FM.

• DNS prefetch is a known limitation of Internet Explorer 11. If GigaVUE-FM is 
configured with DNS and you are using Internet Explorer 11, every new screen can 
be slowed significantly. If a direct IP address is used instead of a DNS name, the UI 
response is similar to other browsers. It is recommended that you use the 
GigaVUE-FM IP when using Internet Explorer 11 or use either a FireFox or Chrome 
browser instead.

CPU

One or more 64-bit x86 CPUs with virtualization assist 
(Intel-VT or AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for 
virtualization must be enabled on the VMware ESXi host. 
Make sure that the BIOS option for virtualization support 
is not disabled. For more information, see your BIOS 
documentation

RAM At least 8GB

Disk Space
At least 40GB shared (FC, iSCSI, NFS, or FCoE) or 
locally attached storage (PATA, SATA, SCSI) 

Network At least one 1Gb NIC

Table 2-2:  Minimum Virtual Computing Requirements for VMware Hypervisor

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory 

Virtual CPU (vCPU) 2 vCPU

Virtual Storage for Guest 40GB using PVSCSI (VMware Paravirtual SCSI)

80GB (or more) using FabricVUE Traffic Analyzer

Virtual Network Interfaces One vNIC using VMXNET3 (VMware 3rd Generation Paravirtual NIC)

Table 2-1:  Hardware Requirements for VMware Hypervisor

 Hardware Requirements

Browser Version
Mozilla Firefox™ • Version 49.00

Windows® Internet Explorer® • Version 11 and higher

Apple® Safari® • Version 9.1 and Higher

Google®Chrome® • Version 54 and higher

Microsoft Edge • Version 38
8   GigaVUE-FM Installation and Upgrade Guide 



• IE11 Compatibility view mode is not supported.

Install New GigaVUE-FM on VMware ESXi
The GigaVUE-FM software package is distributed as an OVA file. The following 
sections describe how to deploy a fresh installation of GigaVUE-FM on an ESXi host 
and perform its initial configuration:

• Deploy GigaVUE-FM from an OVA File on page 9

• Initial GigaVUE-FM Configuration on page 19

Upgrades and OVA Files

You can also use the GigaVUE-FM OVA file to upgrade an existing deployment. 
However, settings and data are not retained when updating from an OVA file. Upgrade 
using the provided image file to retain settings and data across an upgrade. For details, 
refer to Upgrade an Existing GigaVUE-FM Deployment on page 59.

Deploy GigaVUE-FM from an OVA File

Use the vSphere Client to install the GigaVUE-FM OVA file. Starting from software 
version 5.3, you cannot deploy GigaVUE-FM directly from the ESXi host. You must 
login to the VCenter on the vSphere client to deploy a GigaVUE-FM instance.

NOTE: The OVA file must be stored in a location that is accessible to the vSphere 
Client. This location cannot be a datastore accessible to the ESXi host which will be the 
target of the deployment. 

The following steps are shown using the ESXi version 5.5 Update 2b. ESXi version 6.x 
will use the same steps to deploy GigaVUE-FM; however, the screens may look 
different from the ESXi version 5.5.

NOTE: Starting in software version 5.4.01, you cannot deploy the GigaVUE-FM OVA file 
on older versions of VMware ESXi. If you have an older version of ESXi, then you must 
upgrade your VMware ESXi to at least version 5.5. Otherwise, GigaVUE-FM OVA 
deployment will fail.

If you apply the current GigaVUE-FM release as an image upgrade, then it will not 
change the VM Virtual Hardware version of the existing GigaVUE-FM virtual machine. 
To change the Virtual Hardware version of an existing GigaVUE-FM installation, you 
must shut-down the VM instance and use the 'Upgrade Virtual Hardware' dialog in the 
vSphere client.
 9



To deploy a GigaVUE-FM instance:

1. Log in to vCenter on the vSphere Client. The main page of the vSphere Client 
opens as shown in Figure 2-1.

Figure 2-1: vSphere Client 5.5

2. Select the entry for the ESXi Host or Data Center on which you would like to install 
the GigaVUE-FM instance in the inventory panel.

3. From the vSphere Client, click the File menu and select Deploy OVF Template as 
shown in Figure 2-2.

Figure 2-2: vSphere Client: OVF Template

4. When the Source page of the Deploy OVF Template wizard opens, do the 
following to open the OVA file:
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Figure 2-3: vSphere Client: Find the Location of the OVA File

a. Click Browse to navigate to the OVA file available on your local machine and its 
accessible network shares or to an HTTP URL.

b. Select the GigaVUE-FM OVA file and click Open. 

The Open dialog closes, returning you to the Source page with the OVA file 
displayed in the field on the page. 

c. Click the Next.

The OVF Template Details page opens, showing the details of the OVA file. 
Figure 2-4 shows an example of the details page.
 11



Figure 2-4: vSphere Client: OVF Template Details

5. Review the EULA for the OVA file, and then click Accept, and then Next.

6. Select the name of the GigaVUE-FM instance and the host to which to deploy it. 

a. When the Name and Location page opens, enter a name for this GigaVUE-FM 
instance, select the location to deploy it to, and then click Next.

Figure 2-5 shows an example of the Name and Location page, where the 
specified name is FM and the specified location is 
DC-2/discovered virtual machine.
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Figure 2-5: vSphere Client: Enter Location for OVA File on ESXi Server

b. Select the host to which you wish to deploy this GigaVUE-FM instance.

NOTE: If you selected a Data Center rather than an ESXi host in Step 2, you are 
prompted to select a host now. 

c. Click Next.

The OVF Wizard performs a validation to ensure that the selected host has all 
the resources required for this GigaVUE-FM deployment. and presents the 
Storage page.

7. Select the storage location for the virtual machine files by doing the following:

a. After the Storage page opens, choose the datastore where the virtual 
machine’s files will be stored.

b. Click Next.

Figure 2-6 shows an example of the Storage page with the datastore selected.
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Figure 2-6: vSphere Client: Storage Information Verification

8. Set the disk format by doing the following:

a. After Disk Format page opens, select Thick Provisioning as the format for the 
virtual disks and provisioning.

NOTE: You must deploy FM using Thick Provisioning. Any other choice results in 
FM not working correctly.

b. Click Next.

Figure 2-7shows an example of the Disk Format page with Thick Provisioning 
selected.
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Figure 2-7: vSphere Client: Select Datastore

9. After the Network Mapping page opens, set network mapping by doing either of 
the following, depending on how your are deploying, and then click Next:

• If you are not deploying on a standalone ESXi host, the Network Mapping 
displays under Source Networks. Use the drop-down lists to assign the correct 
Destination Network to the source network. 

• If you are deploying GigaVUE-FM on a standalone ESXi host, the network 
mapping is set automatically by assigning the destination network to the 
VM Network. In case of multiple port groups, you need to manually assign the 
destination network to the VM Network.

Figure 2-8 shows an example of the Network Mapping page.
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Figure 2-8: vSphere Client: Network Mapping Menu

10. In the Properties page, enter the hostname of the GigaVUE-FM instance and set 
the admin password. The admin password must be a minimum of 8 characters and 
a maximum of 30 characters. The characters must include at least:

• One numerical character

• One upper case character

• One lower case character

• One special character

NOTE: Keep in mind that admin123! is not an acceptable password. Empty 
passwords will also not be accepted.

If the password does not meet the complexity requirements:

• The system does not display any error message.

• The parameters configured above are not passed on to the GigaVUE-FM 
except the host name parameter.

• The static IP addresses that were configured originally will be unavailable after 
GigaVUE-FM is deployed.

If the password has not been accepted, you must login to the console with the admin/
admin123A! credentials after deployment and configure the devices using the 
jump-start wizard (which is automatically invoked).

11. Configure the IP networking information and click Next.
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Figure 2-9: vSphere Client: Properties Page

12. After the Ready to Complete page opens, do the following:

a. Verify that all of the settings are correct.

b. (Optional) Select Power on after deployment.

NOTE: Do not select Power on after deployment if you want to change the default 
configuration of GigaVUE-FM. The configuration changes could be as follows—
adding vCPUs, increasing the memory size, or adding another Network Interface 
Card. For more information on these configurations, refer to Perform Initial 
Configuration on page 20.

c. Click Finish.

Figure 2-10 shows an example of the Ready to Complete page.
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Figure 2-10: vSphere Client: Final Verification before Installing

After clicking Finish, a dialog opens (refer to Figure 2-11), showing the progress of 
the deployment operation. When the operation completes, you have successfully 
deployed a GigaVUE-FM instance.

Figure 2-11: vSphere Client: Dialog Showing the Installation Progress

Important: Clear the browser cache before logging in to GigaVUE-FM!
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Redeploy GigaVUE-FM Instance (with VMs Already Deployed) 
If there is a need to remove an existing instance of GigaVUE-FM and reinstall it, delete 
all the virtual centers configured in the Virtual > Management > Virtual Center tab prior 
to deleting the GigaVUE-FM. To re-install GigaVUE-FM, refer to the Install New 
GigaVUE-FM on VMware ESXi or Install GigaVUE-FM for Microsoft Hyper-V.

By deleting the virtual centers, you will lose all the GigaVUE-VM nodes and vMaps 
configured on those virtual centers and they will need to be recreated.

Initial GigaVUE-FM Configuration 
After you have deployed a new GigaVUE-FM instance, you need to perform an initial 
configuration before you can start using GigaVUE-FM. This procedure only needs to be 
performed once for each GigaVUE-FM instance deployed.

NOTE: Use Care when Shutting Down or Rebooting a GigaVUE-FM. Never directly 
Power-Off the virtual machine. In VMware ESXi environment when using vSphere 
client, ALWAYS use Shut Down Guest OS or Restart Guest functions from VMware. 
Access is available from either the FILE menu or from the appropriate buttons on the 
GigaVUE-FM console. Failure to follow these steps may lead to database corruption 
issues.

Use Fault Tolerance for GigaVUE-FM Deployments (VMware ESXi only)
Gigamon recommends that you enable the VMware Fault Tolerance feature for the 
GigaVUE-FM virtual machine, providing redundancy in the case of a failure. Enabling 
the VMware Fault Tolerance feature provides a “hot” GigaVUE-FM virtual machine 
instance on another ESXi host in the cluster. If the ESXi host with the primary 
GigaVUE-FM instance goes down, you can take advantage of the Fault Tolerance 
feature to continue GigaVUE-FM operations. 

When in Fault Tolerance mode, the MAC address and the UUID for both the primary 
GigaVUE-FM and the “hot” GigaVUE-FM virtual machine instance remains the same, 
therefore there is no need to update the existing licenses for GigaVUE-FM or 
GigaVUE-VM that are installed on the primary.

Both instances of the GigaVUE-FM implement VMware vLockstep technology to keep 
in virtual lockstep with each other. Any events are executed on the primary and then 
transmitted over a Gigabit Ethernet network to the other instance. Both instances 
access a common disk and appear as a single instance since they share the MAC 
address and UUID.

NOTE: Refer to the VMware Fault Tolerance documentation for deployment 
requirements and instructions. 

Depending on the host configurations, there may be a need to shutdown GigaVUE-FM 
(primary) to enable the Fault Tolerance mode.
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Perform Initial Configuration
Before powering on GigaVUE-FM, you can optionally perform the following:

• Add Additional vNIC on page 20

• Increase the Memory on page 22 

• Add vCPUs on page 23

Add Additional vNIC

Gigamon allows you to configure GigaVUE-FM with two network interfaces—eth0 and 
eth1. The network interface eth0 can be configured to connect to a network used to 
manage Gigamon devices. The other network interface eth1 can be configured to 
connect to a network hosting different servers like SMTP server, Archive server, and so 
on.

To add an additional vNIC:

1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to 
Figure 2-12.

Figure 2-12: vSphere Client: Edit Settings

2. In the Hardware tab, click Add.
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3. In the Add Hardware dialog box, select Ethernet Adapter and then click Next. 

Refer to Figure 2-13.

Figure 2-13: vSphere Client: Selecting Ethernet Adapter

4. In the Adapter Type drop-down list, select an appropriate adapter type. Refer to 
Figure 2-14.

Figure 2-14: vSphere Client: Selecting Device Type

5. In the Named network with specified label drop-down list, select an appropriate 
network and click Next.

The Network adapter 2 is added to GigaVUE-FM.
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Increase the Memory

Based on the requirement, you can increase the memory of the GigaVUE-FM instance.

To increase the memory:

1. Right-click the GigaVUE-FM instance and select Edit Settings... Refer to 
Figure 2-15.

Figure 2-15: vSphere Client: Edit Settings

2. In the Hardware tab, select Memory.

3. In Memory Configuration, increase the size of the memory as per your requirement. 
Refer to the recommended size for your guest OS in the dialog box. Refer to 
Figure 2-16.

Figure 2-16: vSphere Client: Increasing Memory
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4. Click OK.

Add vCPUs

Based on the requirement, you can add additional vCPUs to the GigaVUE-FM 
instance.

1. Right-click the GigaVUE-FM instance and select Edit Settings...

2. In the Hardware tab, select CPUs. Refer to Figure 2-17.

Figure 2-17: vSphere Client: Adding vCPUs

3. In the Number of virtual sockets field, enter the appropriate number of sockets.

4. In the Number of cores per socket field, enter the appropriate number of cores 
per socket.

5. Click OK.

Following are the steps to perform the initial configuration of GigaVUE-FM after 
installing on VMware ESXi:

1. Log in to vCenter in the vSphere Client.

2. Ensure that the UTC time for GigaVUE-FM is configured correctly. Refer to the 
vSphere documentation for instructions on how to set the time.

3. If you checked the Power on after deployment box at the end of the GigaVUE-FM 
deployment in the previous procedure, then the GigaVUE-FM instance starts 
automatically in vSphere Client.

If you did not check the box, you can power GigaVUE-FM on now by right-clicking 
the GigaVUE-FM instance (refer to Figure 2-18) in the vSphere Client by selecting 
Power, and then Power On.

A GigaVUE-FM console displays a login prompt.
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Figure 2-18: GigaVUE-FM in vSphere Client

4. Log in as admin with password admin123A!

For a new installation of GigaVUE-FM, a password is required. 

Figure 2-19: Jump Start Configuration Starts Automatically

5. The jump start configuration for GigaVUE-FM starts automatically.
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Figure 2-20: Jumpstart Wizard for GigaVUE-FM

6. Provide a unique hostname for GigaVUE-FM. Note that the hostname may contain 
letters, numbers, periods (.), and hyphens (-), but may not begin with a hyphen. No 
other special characters are permitted. The hostname will display as part of the 
command line prompt after configuration jump-start completes.

7. To enable DHCP on eth0 interface, type yes and press enter.

8. Enter the primary IP address and the mask length, and then press enter.

9. Enter the default gateway and press enter.

10. Enter the primary DNS server address and press enter. Refer to Figure 2-21.

Figure 2-21: Jump-Start Wizard for Network Interface Configuration

11. (optional) To enable DHCP on eth1 interface, type yes and press enter. Follow 
steps 7 to 10 to enable DHCP on eth1 interface.

12. Provide an appropriate password for your environment. (Type a password and 
press Enter, or just press Enter to leave the password unchanged.)

NOTE: GigaVUE-FM requires a password.

13. For configuration options:
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a. Additional Domain Name Server IP Addresses? - the address of any 
additional name servers required. These must be provided as a set of IP 
addresses with spaces as shown in the Figure 2-22.

b. Additional DNS Domains? - Multiple DNS domains can be defined in the jump 
start configuration with spaces in between as shown in Figure 2-22.

c. Enable NTP? [no] - the default is set to “yes”, the following options are 
available:
NTP Server IP Address? - enter the NTP server address

NTP Server Version? - enter the NTP version number of the NTP server

Figure 2-22: Jumpstart Wizard for Additional Domain Name Server IP Addresses
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14. The console displays the summary of the chosen selections with instructions on 
how to make changes, as needed.

Figure 2-23: Summary of the Selections from Jumpstart Menu

15. Press Enter to save your choices and exit the wizard. 
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The initial configuration is saved and GigaVUE-FM is up and running. GigaVUE-FM is 
now accessible using a web browser, using IP address specified in the jumpstart steps. 
Also the first time GigaVUE-FM starts, a EULA is presented. Accept the EULA to 
continue and see a dashboard similar to the one shown in Figure 2-24.

Figure 2-24: Instance of GigaVUE-FM from Web Client

Configure SSH Settings
SSH access is enabled by default on new GigaVUE-FM and GigaVUE-VM 
deployments. By default, the SSH server runs on port 22.

GigaVUE-FM can be configured to use a custom port for its SSH server with the ssh 
server ports <port number> command followed by a write memory command to 
save the configuration. For example, the following commands change the SSH port 
number to 2222.
(config) # ssh server ports 2222
(config) # write memory
(config) #

After making the settings shown above in the GigaVUE-FM CLI, you can connect an 
SSH session to GigaVUE-FM using the new port number from a web client.
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HTTP/HTTPS Ports
GigaVUE-FM uses the following standard HTTP configuration shown in Figure 2-25

Figure 2-25: GigaVUE-FM CLI Screen to Configure Web Client

HTTPS port can be changed for GigaVUE-FM but the HTTP port is hard-coded to 80. 
As long as HTTP redirect to HTTPS is enabled (the default), connections to the fixed 
HTTP port of 80 will redirect to whatever the configured HTTPS port is.

Install Third-Party Certificate
Use the following procedure to install a third-party certificate on GigaVUE-FM:

1. Generate a certificate and a private key file in pem format. Use the following 
command on Linux or a Linux app (such as Cygwin) for generating the files:

openssl req -x509 -nodes -days 365 -newkey rsa:2048 -keyout privatekey.pem -out certificate.pem

2. Copy the contents of the certificate file. You will use the contents in Step 5.

NOTE: When you copy the contents, do not delete the EOL characters at the start of 
each line.

3. Log in to the GigaVUE-FM CLI.

4. Enable configuration mode by entering the following commands:
> en
# conf t

5. Use the crypto certificate command to add a new certificate. In the following 
example, the certificate is named “my-cert” an and the contents of the public 
certificate pem file is copied inside the quotes.
(config) # crypto certificate name my-cert public-cert pem “<contents-of-public-certificate-pem>” 

6. Copy the contents of the private key file. You will use the contents in Step 7.

7. Use the following command to add the private key, which is “my-cert” in this 
example. The contents of the private key pem file is copied between the quotes.
(config) # crypto certificate name my-cert private-key pem “<contents-of-private-key-pem-file>”

The private key file and certificate are installed and ready to use.

8. Set the certificate (“my-cert” in this example) to be the default self-signed certificate 
by using the following command:
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(config) # crypto certificate default-cert name my-cert

The system will now start using the newly installed certificate.

Install Third-Party Certificate on GigaVUE-FM in AWS

Use the following procedure to install a third-party certificate on GigaVUE-FM that is 
hosted in AWS:

1. Log in to GigaVUE-FM. 

2. Execute the following steps from the shell prompt as a root user (sudo):

• Replace SSLCertificateFile: /etc/pki/tls/certs/localhost.crt 

• Replace SSLCertificateKeyFile: /etc/pki/tls/private/localhost.key

• Provide access to certificate and key files: chmod 777

• Restart apache as root systemctl restart hhtps.
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3 Install GigaVUE-FM on MS Hyper-V 
This section describes how to install and configure GigaVUE-FM in a 
Microsoft Hyper-V environment. It consists of the following main sections:

• System Requirements on page 31 describes the hardware requirements.

• Install GigaVUE-FM for Microsoft Hyper-V on page 33 describes the 
steps to install and deploy GigaVUE-FM.

• Initial GigaVUE-FM Configuration on page 43 describes the steps to start 
GigaVUE-FM instance and configure it.

• Configure SSH Settings on page 44 describes the SSH settings

• HTTP/HTTPS Ports on page 45 describers how to setup the HTTP client

System Requirements
This section describes the hardware and virtual computing requirements for 
GigaVUE-FM. Before installing GigaVUE-FM, ensure that a supported 
version of Windows Server is installed on hardware that meets minimum 
requirements (see Windows Server Hardware Requirements on page 32 for 
hardware requirements).

Ensure that the GigaVUE-FM time is set correctly to ensure accuracy of the 
trending data that is captured.

The Hyper-V implementations provided by the following Windows Server 
versions have been tested and found to operate acceptably with 
GigaVUE-FM:

• Windows Server 2012 R2 and later
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Windows Server Hardware Requirements

The following table describes the minimum requirements for the hardware on which 
Microsoft Hyper-V runs GigaVUE-FM.

NOTE: Refer to the Microsoft documentation for information on enabling Hyper-V.

The following table lists the virtual computing resources that the Windows Server must 
provide for each GigaVUE-FM instance.

Supported Browsers
GigaVUE-FM v3.5 has been tested on the following browsers:

Notes:

• Only the browsers that support TLS v1.2 can access GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor Microsoft Hyper-V

CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT or 
AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization must be 
enabled. Make sure that the BIOS option for virtualization support is not 
disabled. For more information, see your BIOS documentation

RAM At least 8GB

Disk Space At least 41GB shared (FC, iSCSI, NFS, or FCoE) or locally attached 
storage (PATA, SATA, SCSI) 

Network At least one 1Gb NIC

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory

Virtual CPU 2 vCPU

Virtual Storage for Guest 41GB using Virtual IDE (the Hyper-V default)

Virtual Network Interfaces 1 vNIC using Hyper-V Virtualized NIC (the Hyper-V default)

Browser Version
Mozilla Firefox™ • Version 47

Windows® Internet Explorer® • Version 11

Apple® Safari® • Version 9.1

Google®Chrome® • Version 52

Microsoft Edge • Version 38
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• DNS prefetch is a known limitation of Internet Explorer 11. If GigaVUE-FM is 
configured with DNS and you are using Internet Explorer 11, every new screen can 
be slowed significantly. If a direct IP address is used instead of a DNS name, the UI 
response is similar to other browsers. It is recommended that you use the 
GigaVUE-FM IP when using Internet Explorer 11 or use either a FireFox or Chrome 
browser instead.

• IE11 Compatibility view mode is not supported.

Install GigaVUE-FM for Microsoft Hyper-V
The GigaVUE-FM software package for Microsoft Hyper-V environments is distributed 
as an ISO image file. The following sections describes how to deploy a fresh 
installation of GigaVUE-FM on a Hyper-V host and perform its initial configuration:

• Install GigaVUE-FM from an ISO Image File
• Initial GigaVUE-FM Configuration on page 43

Install GigaVUE-FM from an ISO Image File
Use the Hyper-V Manager to install the GigaVUE-FM ISO image file. 

NOTE: The ISO image file must be stored in a location that is accessible to the Hyper-V 
Manager.

To create the Virtual Machine for GigaVUE-FM in Microsoft Hyper-V:

1. Open Hyper-V Manager by clicking Start > Administrative Tools > Hyper-V 
Manager.

2. From the Actions pane, click New > Virtual Machine. Refer to Figure 3-1.

The New Virtual Machine Wizard opens.
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Figure 3-1: Opening the Virtual Machine Wizard
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3. Read the notes on the Before You Begin screen (refer to Figure 3-2), and then click 
Next to continue.

Figure 3-2: Before You Begin Screen

4. After the Specify Name and Location page of the New Virtual Machine Wizard 
opens, which is shown in Figure 3-3, do the following:

a. Supply a descriptive name for the GigaVUE-FM virtual machine in the Name 
field. 

By default, the virtual machine will be stored in the default configuration folder 
shown in the Location text box. You can change this default location by 
checking the Store the virtual machine in a different location checkbox and 
providing a custom path.
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b. Select Next to continue.

Figure 3-3: Name and Location Page

5. On the Specify Generation, select Generation 1 as shown in Figure 3-4

It is important to select Generation 1 and not Generation 2. Selecting Generation 2 
may lead to failure of the GigaVUE-FM installation process because the CD Drive is 
presented as an SCSI device and not IDE.

Figure 3-4: Specify Generation Page
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6. Click Next to continue.
The Assign Memory page of the New Virtual Machine Wizard opens, which is 
shown in Figure 3-5.

Figure 3-5: Assign Memory Page

7. Change the Memory assigned to this virtual machine to 4096 MB, and then click 
Next to continue.

The Configure Networking page of the New Virtual Machine Wizard opens, 
which is shown in Figure 3-6.
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Figure 3-6: Configure Networking Page

8. Choose the virtual network to which GigaVUE-FM will connect from the drop-down 
list, and then click Next to continue. 

The Connect Virtual Hard Disk page of the New Virtual Machine Wizard opens, 
which is shown in Figure 3-7.

Figure 3-7: Connect Virtual Hard Disk Page

9. Select the Create a virtual hard disk option and set the Size to 41 GB.
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You can accept the default Name and Location or customize them according to 
your needs. When you have finished, click Next to continue.

The Installation Options page of the New Virtual Machine Wizard opens., which 
is shown in Figure 3-8.

10. Use this dialog box to select the ISO image file for GigaVUE-FM. As shown in the 
figure Figure 3-8, set the following options:
a. Select the option Install an operating system from a boot CD/DVD-ROM.

b. Set the Media option to Image file (.iso).
c. Use the Browse button to navigate to the GigaVUE-FM ISO image file.
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d. Click Next to continue.

Figure 3-8: Install Options Page

After clicking Next, the summary page of the New Virtual Machine Wizard 
opens, showing the settings that you configured for the GigaVUE-FM virtual 
machine. An example is shown in Figure 3-9.

Figure 3-9: Summary Page
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11. Click Finish to create the GigaVUE-FM virtual machine as configured. 
Alternatively, you can use the Previous button to go back and change settings. 

The New Virtual Machine Wizard only creates the GigaVUE-FM virtual machine, 
returning you to the Hyper-V Manager when creation is complete. The new 
GigaVUE-FM virtual machine is listed in the Action pane by the name you supplied 
during installation. The rest of this procedure will take you through the steps of 
actually installing GigaVUE-FM.

Connect and Power On the GigaVUE-FM Virtual Machine

The next step is to connect to the GigaVUE-FM virtual machine from within Hyper-V 
Manager and start it. This begins the actual installation of the GigaVUE-FM Virtual 
Appliance from the connected ISO image file. Once GigaVUE-FM finishes installing 
from the ISO image file, you will then disconnect the ISO image file and restart the 
virtual machine.

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane, 
right-click the GigaVUE-FM virtual machine, and click the Connect option.

2. The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.

3. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual 
Machine Connection tool.
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4. The GigaVUE-FM virtual machine powers on. You can monitor the progress of the 
system start in the Virtual Machine Connection tool.

The system power-on can take several minutes as GigaVUE-FM is installed from 
the ISO image file. Disconnect the media before Powering On as shown below:

Disconnect the ISO Image File

It is important to disconnect the ISO image file before you power on GigaVUE-FM 
again so you don’t have to go through the image install process again. Disconnect the 
ISO image file as follows:

1. In Hyper-V Manager, locate the Virtual Machines entry in the results pane and 
select the GigaVUE-FM virtual machine.

2. In the Actions pane, click the Settings entry under the GigaVUE-FM virtual 
machine name.

A Settings dialog box for the GigaVUE-FM virtual machine appears.

3. Select the DVD Drive entry in the panel on the left of the Settings dialog box and 
change its setting from Image file to None, as shown in the figure below.

4. Click the OK button to apply the changes.

This concludes the installation procedure for GigaVUE-FM on Hyper-V. The next step is 
to power on the virtual machine and perform its initial configuration, as described in 
Initial GigaVUE-FM Configuration on page 43.

IMPORTANT: Clear the browser cache before logging in to GigaVUE-FM!
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Initial GigaVUE-FM Configuration 
After you have deployed a new GigaVUE-FM instance, you need to perform an initial 
configuration before you can start using GigaVUE-FM. This procedure only needs to be 
performed once for each GigaVUE-FM instance deployed.

NOTE: Use Care When Shutting Down or Rebooting a GigaVUE-FM. Never directly 
Power-Off the virtual machine. For Microsoft Hyper-V environment, you cannot use any 
of the reset, or turn-off hooks. Using either of these may lead to corruption that will 
prevent proper GigaVUE-FM operation. 

The best ways to shutdown a GigaVUE-FM on Hyper-V is to use either Shutdown or 
Ctrl+Alt+Del from the Action button on the virtual console.

To perform the initial configuration:

1. Open Hyper-V Manager by clicking Start > Administrative Tools > Hyper-V 
Manager.

2. Make sure you have already disconnected the ISO image file used to install 
GigaVUE-FM. Refer to Disconnect the ISO Image File on page 42 for details.

3. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM 
virtual machine, and click the Connect option.

The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.
4. Select Action > Start to start the GigaVUE-FM virtual machine from the Virtual 

Machine Connection tool.

The GigaVUE-FM virtual machine powers on and displays a login prompt. 

5. Log in as admin with password admin123A!
The configuration wizard starts automatically, as shown in the following figure.
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6. At this point, the wizard presented a series of steps for you to provide the initial 
configuration for GigaVUE-FM. These are the steps

a. Provide a unique hostname for GigaVUE-FM. Note that the hostname may 
contain letters, numbers, periods (.), and hyphens (-), but may not begin with a 
hyphen. No other special characters are permitted.

b. Decide whether to use DHCP for the management interface.
If you choose no, you will be prompted to provide the following:

- IPv4 address and masklen

- Default gateway

- Primary DNS server

- Domain name

If you choose yes, skip to Step c
c. If you choose Yes for Step b, follow these instructions. The same options are 

repeated if DHCP is selected as No, but only one DNS IP address and domain 
server can be listed.

For configuration options:

•Additional Domain Name Server IP Addresses? - the address of any 
additional name servers required must be provided as a set of IP addresses 
with spaces as shown in the following figure.

•Additional DNS Domains? - Multiple DNS domains can be defined in the 
jump start configuration with spaces in between as shown in the following 
figure.

•Enable NTP? [yes] - the default is set to “yes”. The following options are 
available:

•NTP Server IP Address? - enter the NTP server address

•NTP Server Version? - enter the NTP version number of the NTP server

7. Provide an appropriate password for your environment. (Type a password and 
press Enter, or just press Enter to leave the password unchanged.)

NOTE: Blank passwords are not permitted.

The console displays your selections with instructions on how to make changes, if 
necessary.

8. Press Enter to save your choices and exit the wizard. 

9. Your initial configuration is saved and GigaVUE-FM is up and running. You should 
now be at a standard mode command prompt. 

You can now access GigaVUE-FM by opening a browser and entering its IP 
address (the IP address you specified).

Configure SSH Settings
SSH access is enabled by default on new GigaVUE-FM deployments. You can enable 
SSH from the CLI using the ssh server enable command. By default the SSH server 
runs on port 22.
44   GigaVUE-FM Installation and Upgrade Guide 



You can configure GigaVUE-FM to use a custom port for its SSH server with the ssh 
server ports <port number> command followed by a write memory command to 
save the configuration. For example, the following CLI commands change the SSH port 
number to 2222.

(config) # ssh server ports 2222
(config) # write memory
(config) #

After making the settings shown above with the GigaVUE-FM CLI command, you can 
connect an SSH session to GigaVUE-FM using the new port number.

HTTP/HTTPS Ports
GigaVUE-FM uses the standard HTTP configuration shown in the following figure:

In this release, you can change the HTTPS port for GigaVUE-FM but the HTTP port is 
hard-coded to 80. As long as HTTP redirect to HTTPS is enabled (the default), 
connections to the fixed HTTP port of 80 will redirect to whatever the configured 
HTTPS port is.

Make Sure the Web Server is Enabled on Nodes to be Managed

GigaVUE-FM can only discover and manage nodes with their web servers enabled and 
operating on the default HTTP port of 80. Both G and H Series nodes have their web 
servers enabled by default. However, if you disabled a node’s web server or changed 
its HTTP port, you will need to restore the settings before GigaVUE-FM can manage it.

GigaVUE-FM can manage nodes operating on custom HTTPS ports. Incoming HTTP 
connections redirect to the custom HTTPS port.
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The show web_server and show web output listed below summarizes the necessary 
HTTP settings for G and H Series GigaVUE nodes managed by GigaVUE-FM. The 
items shown in red are required settings.

G Series
G Series>show web_server
Admin      : 1 (Must be enabled)
Operation  : 1
HTTP port  : 80 (Must remain at its default setting of 80)
HTTPS port : 8000 (Can be set to any custom value; HTTP redirects here)
Timeout    : 5 (minutes)
HTTPS Cert : Default Certificate

H Series
H Series (config) # show web
Web-based management console enabled: yes
HTTP enabled:           yes (Must be enabled)
HTTP port:              80 (Must remain at its default setting of 80)
HTTP redirect to HTTPS: yes (Must remain enabled)
HTTPS enabled:          yes (Must remain enabled)
HTTPS port:             443 (Can be set to any custom value; HTTP                              redirects here)
Listen enabled:         yes
No Listen Interfaces.
Inactivity timeout:     15 min
Session timeout:        2 hr 30 min
Session renewal:        30 min
Web proxy enabled: no
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4 Install GigaVUE-FM on KVM
This section describes how to install and configure GigaVUE-FM in a KVM 
environment. It consists of the following main sections:

• System Requirements on page 47 describes the hardware requirements.

• Install GigaVUE-FM for KVM on page 49 describes the steps to install 
and deploy GigaVUE-FM.

• Initial GigaVUE-FM Configuration on page 54 describes the steps to start 
GigaVUE-FM instance and configure it.

• Configure SSH Settings on page 56 describes the SSH settings.

• HTTP/HTTPS Ports on page 56 describers how to setup the HTTP client.

Limitations
You can install GigaVUE-FM in a KVM environment, but you cannot access 
GigaVUE-FM through CLI in a KVM environment using SSH. In KVM, you 
can only access the GigaVUE-FM CLI using the VNC console.

System Requirements
This section describes the hardware and virtual computing requirements for 
GigaVUE-FM. Ensure that the GigaVUE-FM time is set correctly to ensure 
accuracy of the trending data that is captured.
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Linux Server Hardware Requirements
The following table describes the minimum requirements for the hardware on which 
KVM runs GigaVUE-FM.

The following table lists the virtual computing resources that the Linux Server must 
provide for each GigaVUE-FM instance.

Supported Browsers
GigaVUE-FM has been tested on the following browsers:

Notes:

• Only the browsers that support TLS v1.2 can access GigaVUE-FM.

Minimum Hardware Requirements

Hypervisor KVM

Supported (tested on previous versions of GigaVUE-FM)

• v2.0.0

CPU One or more 64-bit x86 CPUs with virtualization assist (Intel-VT or 
AMD-V) enabled.

Note: To run GigaVUE-FM, hardware support for virtualization must be 
enabled. Make sure that the BIOS option for virtualization support is not 
disabled. For more information, see your BIOS documentation.

RAM At least 8GB.

Disk Space At least 40GB shared (FC, iSCSI, NFS, or FCoE) or locally attached 
storage (PATA, SATA, SCSI).

Network At least one 1Gb NIC.

Minimum Virtual Computing Requirements

Memory Minimum 8GB memory

Virtual CPU 2 vCPU

Virtual Storage for Guest 41GB

Virtual Network Interfaces One vNIC 

Browser Version
Mozilla Firefox™ • Version 47

Windows® Internet Explorer® • Version 11

Apple® Safari® • Version 9.1

Google®Chrome® • Version 52

Microsoft Edge • Version 38
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• DNS prefetch is a known limitation of Internet Explorer 11. If GigaVUE-FM is 
configured with DNS and you are using Internet Explorer 11, every new screen can 
be slowed significantly. If a direct IP address is used instead of a DNS name, the UI 
response is similar to other browsers. It is recommended that you use the 
GigaVUE-FM IP when using Internet Explorer 11 or use either a FireFox or Chrome 
browser instead.

• IE11 Compatibility view mode is not supported.

Install GigaVUE-FM for KVM
The GigaVUE-FM software package for KVM environments is distributed as an ISO 
image file. The following sections describes how to deploy a fresh installation of 
GigaVUE-FM on a KVM host and perform its initial configuration:
• Install GigaVUE-FM from an ISO Image File
• Initial GigaVUE-FM Configuration on page 54

These steps are only valid for new installations of GigaVUE-FM.

Install GigaVUE-FM from an ISO Image File
Use the Virtual Machine Manager to install the GigaVUE-FM ISO image file. 

NOTE: The ISO image file must be stored in a location that is accessible to the 
Manager.

To create the Virtual Machine for GigaVUE-FM in KVM:

NOTE: These instructions use “Virtual Machine Manager” to create and manage the 
virtual machines (VMs). 

1. Open the Virtual Machine Manager by using virt-manager from the command line. 
Select Create a new virtual machine. The New Virtual Machine Wizard opens.
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2. Then, specify Name and Location.

It is recommended to supply a descriptive name for the GigaVUE-FM virtual 
machine in the Name field. 

Click Forward to continue.
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3. Enter the Location from where to upload the GigaVUE-FM iso image and choose 
the OS type and Version.

Click Forward to continue.
4. Set the Memory and CPU Settings.

Click Forward to continue.
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5. Enable the storage for this virtual machine option and set the Size to 41 GB. 
Select Allocate entire disk now. When you have finished, click Forward to 
continue.

6. On the next screen, select Customize configuration before install.
• Use the Advanced options to set the VM connection to the network adapter. 

• Connect the VM to the network that you have configured on your hypervisor 
that ensures the network connectivity to your managed VMs.

• Ensure that the Virt Type is set to KVM
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7. The Summary page of the New Virtual Machine Wizard opens, showing the 
settings you have configured for the GigaVUE-FM virtual machine.

8. Connect and power on the GigaVUE-FM Virtual Machine.
 53



Initial GigaVUE-FM Configuration 
After you have deployed a new GigaVUE-FM instance, you need to perform an initial 
configuration before you can start using GigaVUE-FM. This procedure only needs to 
be performed once for each GigaVUE-FM instance deployed.

To perform the initial configuration:

1. Open Virtual Machine Manager.
2. Locate the Virtual Machines entry in the results pane, right-click the GigaVUE-FM 

virtual machine, and click the Open option.
The Virtual Machine Connection tool opens for the GigaVUE-FM virtual machine.

3. Open the GigaVUE-FM virtual machine from the Virtual Machine tool.

4. The GigaVUE-FM virtual machine powers on and displays a login prompt. 

5. Log in as admin with password admin123A!
The configuration wizard starts automatically, as shown in the figure below.

6. At this point, you will be presented with a series of prompts for you to provide the 
initial configuration for GigaVUE-FM.
a. Provide a unique hostname for GigaVUE-FM. Note that the hostname may 

contain letters, numbers, periods (.), and hyphens (-), but may not begin with a 
hyphen. No other special characters are permitted.
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b. Decide whether to use DHCP for the management interface.
If you choose no, you will be prompted to provide the following:
- IPv4 address and masklen
- Default gateway
- Primary DNS server 
- Domain name
If you choose yes, skip to Step c

c. If you choose Yes for Step b, follow these instructions. The same options are 
repeated if DHCP is selected as No, but only one DNS IP address and domain 
server can be listed.

For configuration options:

•Additional Domain Name Server IP Addresses? - the address of any 
additional name servers required must be provided as a set of IP addresses 
with spaces as shown in the following figure.

•Additional DNS Domains? - Multiple DNS domains can be defined in the 
jump start configuration with spaces in between as shown in the following 
figure.

•Enable NTP? [yes] - the default is set to “yes”. The following options are 
available:

NTP Server IP Address? - enter the NTP server address

NTP Server Version? - enter the NTP version number of the NTP server

7. Provide an appropriate password for your environment. (Type a password and 
press Enter, or just press Enter to leave the password unchanged.)

NOTE: Blank passwords are not permitted.
The console displays your selections with instructions on how to make 
changes, if necessary.

8. Press Enter to save your choices and exit the wizard. 

9. Your initial configuration is saved and GigaVUE-FM is up and running. You should 
now be at a standard mode command prompt. 

You can now access GigaVUE-FM by opening a browser and entering its IP 
address (the IP address you specified).
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Configure SSH Settings
SSH access is enabled by default on new GigaVUE-FM deployments. You can enable 
SSH from the CLI using the ssh server enable command. By default the SSH server 
runs on port 22.

You can configure GigaVUE-FM to use a custom port for its SSH server with the ssh 
server ports <port number> command followed by a write memory command to 
save the configuration. For example, the following commands change the SSH port 
number to 2222.
(config) # ssh server ports 2222
(config) # write memory
(config) #

After making the settings shown above in the GigaVUE-FM CLI, you can connect an 
SSH session to GigaVUE-FM using the new port number.

HTTP/HTTPS Ports
GigaVUE-FM uses the following standard HTTP configuration:

In this release, you can change the HTTPS port for GigaVUE-FM but the HTTP port is 
hard-coded to 80. As long as HTTP redirect to HTTPS is enabled (the default), 
connections to the fixed HTTP port of 80 will redirect to whatever the configured 
HTTPS port is.
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Make Sure the Web Server is Enabled on Nodes to be Managed

GigaVUE-FM can only discover and manage nodes with their web servers enabled and 
operating on the default HTTP port of 80. Both G and H Series nodes have their web 
servers enabled by default. However, if you disabled a node’s web server or changed 
its HTTP port, you will need to restore the settings before GigaVUE-FM can manage it.

GigaVUE-FM can manage nodes operating on custom HTTPS ports. Incoming HTTP 
connections redirect to the custom HTTPS port.

The show web_server and show web output listed below summarizes the necessary 
HTTP settings for GigaVUE nodes managed by GigaVUE-FM. The items shown in red 
are required settings.

H Series
H Series (config) # show web
Web-based management console enabled: yes
HTTP enabled:       yes (Must be enabled)
HTTP port:             80 (Must remain at its default setting of 80)
HTTP redirect to HTTPS: yes (Must remain enabled)
HTTPS enabled:       yes (Must remain enabled)
HTTPS port:             443 (Can be set to any custom value; HTTP redirects here)
Listen enabled:         yes
No Listen Interfaces.
Inactivity timeout:      15 min
Session timeout:       2 hr 30 min
Session renewal:     30 min
Web proxy enabled: no
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5 Upgrade GigaVUE-FM
This section describes how to upgrade GigaVUE-FM to the latest revision in 
either a VMware ESXi host or in Microsoft HyperV environment. Starting with 
release 3.1, Gigamon supports KVM environments. Previous versions of 
GigaVUE-FM have not been tested in the KVM environment.

NOTE: To upgrade software on H Series or TA Series nodes, refer to the 
“Upgrading Software on a GigaVUE Node or a Cluster from GigaVUE-FM” 
section in the GigaVUE-FM User’s Guide.

The topic covered in this sections cover:
• Upgrade an Existing GigaVUE-FM Deployment on page 59, which 

describes the overall upgrade path from an existing GigaVUE-FM 
deployment.

• How to Use the Snapshot Feature on page 66, which describes how to 
upgrade GigaVUE-FM 3.1 and above to the current version of 
GigaVUE-FM.

Upgrade an Existing GigaVUE-FM Deployment
Before starting an upgrade to GigaVUE-FM version, be sure to get the latest 
image, upgrade information, and release notes from the customer portal. Be 
sure to review the release notes for the latest release prior to upgrading your 
instance of GigaVUE-FM.

Once the GigaVUE-FM image is obtained, download it to a server within your 
environment from which the current instance of GigaVUE-FM can upload it. It 
is important to save your current running configuration using the facilities 
provided by the hypervisor before upgrading.

NOTE: When upgrading from any version of GigaVUE-FM lower than 5.4.00, 
be aware of the minimum memory requirements in the new release. Earlier 
releases specified 4GB of memory for the OVA template; whereas versions 
after 5.4.00 require 8GB. If the existing virtual or physical hardware running 
GigaVUE-FM is configured with less memory than required, then increase 
the amount of memory available to the GigaVUE-FM machine. 

Ensure that GigaVUE-FM time is set correctly to ensure accuracy of the 
trending data that is captured.
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You can upgrade the existing deployment of GigaVUE-FM either from the CLI or from 
the GigaVUE-FM UI.

NOTE: When upgrading GigaVUE-FM, you must also upgrade GigaVUE-VM. For the 
steps to upgrade GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” 
section in the GigaVUE Cloud Suite for VMware Configuration Guide.

Upgrade from CLI
There are five steps on how to upgrade an existing GigaVUE-FM deployment to the 
current release. 

1. Verify that less than two images are present on the GigaVUE-FM server.

2. Download the new image into GigaVUE-FM using either HTTP, HTTPS, FTP, TFTP, 
SCP, or SFTP.

3. Install the new image.

4. Change boot partition.

5. Reboot GigaVUE-FM.

Notes:

• It is important to log in with the admin account/username when upgrading the 
image on the existing GigaVUE-FM.

• GigaVUE-FM 3.2 and higher versions compute node health status differently than 
previous versions. After the upgrade completes, rediscover the nodes to recompute 
node health status.

• Prior to GigaVUE-FM 3.2, backup files for physical nodes were in a binary format. 
Starting with GigaVUE-FM 3.2, backup and restore files use a text based format 
and binary backup or restore on physical nodes is not supported. When upgrading 
from a version lower than version 3.2, backup your configuration prior to upgrading 
to the current version of GigaVUE-FM if you desire, but the files will be in a binary 
format. Existing binary backups are not visible to GigaVUE-FM. For binary 
backups, you must back up the node using the CLI commands rather than 
GigaVUE-FM. For more information about the CLI commands, refer to the 
GigaVUE-OS CLI Reference Guide.

• When using the Firefox or IE browser, clear the cache before upgrading to prevent 
issues with the browser.

Step 1: Verify that only two images are present on GigaVUE-FM server
NOTE: It is important that you log in with the admin account/username when upgrading 
the image on the existing GigaVUE-FM.

1. To begin an upgrade, open a SSH session or console session within the vSphere 
Client, and log int o GigaVUE-FM and change to configure mode, by entering the 
following on the command line:

a. Type en <Enter> to switch to Enable mode. 

The system prompt changes from [hostname] > to [hostname] #.

b. Type config t <Enter> to switch to Configure mode.
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The system prompt changes from [hostname] # to 
[hostname] (config) #

Figure 5-1shows an example of the login console.

2. Check the number of images currently available for installation with the following 
command from the GigaVUE-FM CLI:
(config) # show images

Important: If there are more than two images listed in the Images available to be 
installed section of the show images output, Gigamon recommends that you use 
the image delete command to remove existing images until the system has only a 
single image. Both GigaVUE-FM and GigaVUE-VM will display a warning if you 
attempt to fetch a third image.

3. To delete an existing image from the server use the following command:
(config) # image delete fma3300.img

4. Go to Step 2: Fetch the latest release of GigaVUE-FM on page 61.

Figure 5-1: Console Login to vSphere Client

Step 2: Fetch the latest release of GigaVUE-FM

Gigamon provides an FTP site where the new release image file resides. To fetch the 
latest release, do the following:

1. Locate the image file for the new release. Image files are named using a 
fmaxxxx.img format. The xxxx indicates the version and build number (for 
example, fma3500.img for the v3.5 release).

2. Copy the image to your file server. 

3. Use the image fetch command to retrieve the software image from your file server. 
The CLI shows you the progress of the image fetch with a series of hash marks, 
returning you to the system prompt when complete.

Note: The image fetch command supports the use of HTTP, HTTPS, FTP, TFTP, 
SCP, or SFTP for the transfer of images.
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a. The following command uses SCP to retrieve the fma3500 image from the 
image server with the IP address of 10.115.0.100 using login and password.
(config) # image fetch scp://user:password@10.115.0.100/fma3500.img

b. The following command uses FTP to retrieve the same image using login and 
password as well.
(config) # image fetch ftp://user:password@10.115.0.100/fma3500.img

c. The following command uses TFTP to retrieve the same image without using a 
password but using a DNS server instead of an IP address for the download 
server.
(config) # image fetch tftp://myserver.gigamon.com/tftpboot/fma3500.img

Ensure that you specify the base directory when using TFTP

4. Go to Step 3: Install the latest release of the GigaVUE-FM on page 62.

Step 3: Install the latest release of the GigaVUE-FM

Use the image install command to install the downloaded image file. When running 
the following command, the process will first verify that the filename used for the image 
is suitable for installation prior to installing the image. For example, to install the image 
downloaded in the previous step:
(config) # image install fma3400.img

Step 4: Change the boot partition

Set the image you just installed to boot next with the following command. This ensures 
that at the next boot the latest image will be picked up.
(config) # image boot next

Step 5: Reboot

The following command shuts down the current instance of GigaVUE-FM and reloads. 
If Step 4 is performed, upon reboot, the new image is used. 
(config) # reload

Step 6: Upgrade GigaVUE-VM

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-VMs. 
Otherwise, maps may not work and the GigaVUE-VMs will be unreachable. For 
information about upgrading GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM 
Nodes” section in the GigaVUE Cloud Suite for VMware Configuration Guide.

CLI Summary of the Upgrade Path

The following summarizes the CLI commands used to upgrade an image after logging 
in from the console:
> en
# config t
(config) # write memory
(config) # show images
(config) # image delete fma3400.img
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(config) # image fetch tftp://192.158.51.41/fma3500.img
(config) # image install fma3500.img
(config) # image boot next
(config) # reload

Upgrade from GigaVUE-FM UI
This section describes the steps to upgrade GigaVUE-FM from the UI. You can 
upgrade by using an image that is located on an external image server, or you can use 
GigaVUE-FM as the image server.

NOTE:
• When using the GigaVUE-FM UI to upgrade GigaVUE-FM, you can only upgrade to 

the currently available version or to the next version. You cannot downgrade.

• When using the Firefox or IE browser, clear the cache before upgrading to prevent 
issues with the browser

Upgrade from External Image Server

This section provides the steps for upgrading the GigaVUE-FM from an image stored 
on an external server. The image can be transfered from the server to the 
GigaVUE-FM using either SCP or TFTP file protocols.

To upgrade with an image stored on an external image server, do the following:

1. Upload the image to the external image server to make it available to GigaVUE-FM.

To obtain software images, register on the customer portal and download the 
software. To reach the customer portal, go to https://gigamoncp.force.com/
gigamoncp/.

2. Add the image server to GigaVUE-FM. This stores the credentials, image file 
name, and IP address of the server on GigaVUE-FM.

To add the image server:

a. In GigaVUE-FM, click  on the top navigation bar.

b. Select System on the left navigation panel and go to Images > External 
Servers. The External Servers page displays as shown in Figure 5-2.
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Figure 5-2: Adding Image Servers

c. Click Add. The Add External Server page displays as shown in Figure 5-3

Figure 5-3: Add External Server

d. On the Images Server page, specify the following:

- An alias to help identify the image server.

- The host IP address of the server.

- The protocol to use for the download: SCP or TFTP.

- The user name and password if you selected SCP. They are not needed for 
TFTP.

e. Click Save.

The External Server page displays the newly added external server.

3. From the Admin drop-down list in the top right corner of the window, select 
Upgrade to open the FM Image Upgrade page shown in Figure 5-4.

Figure 5-4: FM Image Upgrade Page

To monitor the progress and status of the upgrade, click  on the top navigation 
bar and go to Events. Also, email notifications are sent if Email Notifications have 
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been configured. For more information about Email Notifications, refer to the 
“Notifications” section in the “GigaVUE-OS and GigaVUE-FM Administration 
Guide”.

4. On the FM Image Upgrade page, click on the Image Server field and select the 
server added in Step 2.

5. In the Image File Path, enter the image path and filename on the external file 
server.

6. Upgrade any deployed GigaVUE-VMs.

After upgrading GigaVUE-FM, you must also upgrade any deployed 
GigaVUE-VMs. Otherwise, maps may not work and the GigaVUE-VMs will be 
unreachable. For information about upgrading GigaVUE-VM, refer to the “Bulk 
Upgrading GigaVUE-VM Nodes” section in the GigaVUE Cloud Suite for VMware 
Configuration Guide.

NOTE: If you are using FireFox or Internet Explorer, you must refresh the browser to 
ensure that the cached information is not displayed after upgrading to the latest version 
of GigaVUE-FM. 

Upgrade with GigaVUE-FM as the Image Server

This section provides the steps for upgrading GigaVUE-FM when GigaVUE-FM is used 
as the file server instead of an external server.

To upgrade a GigaVUE-FM using internal image files, do the following:

1. Download the images from the Gigamon website and place them where they can 
be available for uploading to GigaVUE-FM.

To obtain software images, register on the customer portal and download the 
software. To reach the customer portal, go to https://gigamoncp.forc.com/
gigamoncp/.

2. Upload the images file to GigaVUE-FM.

a. Click  on the top navigation bar. In the left navigation panel, go to System > 
Images > Internal Image Files.

b. On the Internal Image File page, click Upload.

c. Click Browse to locate the image file.

d. Click OK to upload the file. The page displays the progress of the upload.

After the upload completes, you can see the GigaVUE-FM image to use for the 
upgrade on the Internal Images Files page.
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3. Click the Admin drop-down list on the top right of the window and select Upgrade 
as shown in Figure 5-5.

Figure 5-5: Selecting Upgrade

4. On the FM Image Upgrade page, click in the Image Server field and select 
Internal Image Server.

5. From the Version drop-down list, select the version to which you are upgrading.

NOTE: You can only upgrade to another instance of the current version or the 
immediate next version. Downgrading to a lower version is not supported through 
the UI. To downgrade to an lower version, use the CLI.

6. Click Upgrade.

To monitor the progress and status of the upgrade, click  on the top navigation 
bar and select Events on the left navigation panel. Also, email notifications are sent 
if email notifications have been configured.

7. Upgrade any deployed GigaVUE-VMs.

After upgrading GigaVUE-FM, you must also upgrade any deployed 
GigaVUE-VMs. Otherwise, maps may not work and the GigaVUE-VMs will be 
unreachable. For information about upgrading GigaVUE-FM, refer to the “Bulk 
Upgrading GigaVUE-VM Nodes” section in the GigaVUE Cloud Suite for VMware 
Configuration Guide.

NOTE: If you are using FireFox or Internet Explorer, clear the cache before upgrading to 
prevent issues with the browser.

How to Use the Snapshot Feature
This procedure is only valid for upgrading from GigaVUE-FM v3.0 and above. For 
upgrades from pre-3.0 releases, review the GigaVUE-FM v3.0 User’s Guide and 
upgrade to release GigaVUE-FM v3.1. Then follow the steps below to upgrade to the 
current release version of GigaVUE-FM.

NOTE: You cannot directly upgrade from a pre-3.3 releases to the current release. You 
can only upgrade from GigaVUE-FM v3.3 or v3.4 release.
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1. Prior to upgrading, ensure that the available memory size is at least 8GB prior to 
upgrading to the new GigaVUE-FM release. If the available memory size is less 
than 8GB, it will cause out of memory issues. Also, at least 2 vCPU are required.

2. When upgrading from v3.1, it’s a good idea to use the vSphere client’s Snapshot 
feature to record the current state of the GigaVUE-FM virtual machine. Steps to 
use Snapshot feature are as follows:

a. Log into the vSphere client and navigate to the Datacenter or Cluster level 
where the GigaVUE-FM installation is located.

b. Right-click the GigaVUE-FM entry in the vSphere client and select the Take 
Snapshot option.

Figure 5-6: “Take Snapshot” Command to Preserve Current Settings Prior to Upgrade

c. Follow the system prompts to record a snapshot of GigaVUE-FM’s current 
state.
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Figure 5-7: Power Off Command
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6 Additional Sources of Information
This appendix provides additional sources of information. Refer to the 
following sections for details:

• Documentation on page 69

• Documentation Feedback on page 71

• Contacting Technical Support on page 71

• Contacting Sales on page 71

• The Gigamon Community on page 71

Documentation
Table 6-1 lists the documents that are provided for the various Gigamon 
products. You can download the PDF versions of these documents from the 
Gigamon Customer Portal.

Table 6-1:  Documentation Suite for Gigamon Products

Document Summary

Hardware Installation Guides

GigaVUE-HC1 Hardware Installation 
Guide

Describes how to unpack, assemble, rack-mount, connect, and 
perform the initial configuration of the various GigaVUE nodes. Also 
provides reference information for the respective GigaVUE nodes, 
including specifications.

GigaVUE-HC2 Hardware Installation 
Guide

GigaVUE-HC3 Hardware Installation 
Guide

GigaVUE TA Series Hardware 
Installation Guide

GigaVUE-OS Installation Guide on a 
White Box

Describes how to install the GigaVUE-OS on a white box.

Software Installation and Upgrade Guides

GigaVUE-FM Installation and Upgrade 
Guide

Provides instructions for installing GigaVUE-FM on VMware ESXi, 
MS Hyper-V, and KVM. Also, provides instructions to upgrade 
GigaVUE-FM.

GigaVUE-OS Upgrade Guide Describes how to upgrade a GigaVUE H Series node or a GigaVUE 
TA Series node to the latest GigaVUE-OS.
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Administration Guide

GigaVUE-OS and GigaVUE-FM 
Administration Guide

Describes how to use the GigaVUE-FM interface to administer the 
GigaVUE H Series and GigaVUE TA Series software.

Configuration and Monitoring Guides

GigaVUE-FM User’s Guide Provides instructions for installing, deploying, and operating the 
GigaVUE® Fabric Manager (GigaVUE-FM).

GigaVUE Cloud Suite for VMware 
Configuration Guide

Provides instructions for installing, deploying, and operating the 
GigaVUE® Virtual Machine (GigaVUE-VM).

GigaVUE Cloud Suite for AWS 
Configuration Guide

Provides instructions on configuring the GigaVUE Cloud components 
and setting up traffic monitoring sessions for the respective Cloud 
platform.

GigaVUE Cloud Suite for Azure 
Configuration Guide

GigaVUE Cloud Suite for OpenStack 
Configuration Guide

GigaVUE Cloud Suite for Kubernetes 
Container Configuration Guide

GigaVUE Cloud Suite for AnyCloud 
Configuration Guide

Describes how to deploy the GigaVUE Cloud solution in any of the 
cloud platforms available in the market.

Reference Guides

GigaVUE-OS CLI Reference Guide Describes how to use the CLI (Command Line Interface) to configure 
and operate the GigaVUE H Series and TA Series software.

GigaVUE-OS Cabling Quick Reference 
Guide

Provides guidelines to the different types of cables to be used to 
connect the Gigamon devices as well as connect Gigamon devices 
to third-party devices.

GigaVUE-OS Compatibility and 
Interoperability Matrix

Provides information about the compatibility and interoperability 
requirements for the Gigamon devices.

REST API Getting Started Guide Introduction to the Application Program Interfaces (APIs) for 
GigaVUE-FM and provides an overview of these REST APIs, basic 
work flows, and use cases. The APIs are implemented with the 
Representational State Transfer (REST) architecture.
(Deprecation announcement: This has not been updated since 5.4. 
The content will be merged into the GigaVUE-FM User’s Guide in a 
subsequent release.)

Release Notes

GigaVUE-OS, GigaVUE-FM, 
GigaVUE-VM, and GigaVUE Cloud Suite 
Release Notes

Summarizes new features, resolved issues, and known issues in this 
release for GigaVUE-OS, GigaVUE-FM, and GigaVUE Cloud Suite. 
Also provides important notes regarding installing and upgrading to 
this release.

Document Summary
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Documentation Feedback
To send feedback and report issues in our documentation, complete the short survey at 
the following link: 

https://www.surveymonkey.com/r/gigamondocumentationfeedback 

Contacting Technical Support
See https://www.gigamon.com/support-and-services/contact-support for Technical 
Support hours and contact information. You can also email Technical Support at 
support@gigamon.com.

Contacting Sales
Use the following information to contact sales:

Telephone: +1.408.831.4025

Sales: inside.sales@gigamon.com

Premium Support
Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 
Premium Support. Premium Support entitles you to round-the-clock phone support 
with a dedicated Support Engineer every day of the week.

The Gigamon Community
The Gigamon Community is a technical site where Gigamon users, partners, security 
and network professionals and Gigamon employees come together to share 
knowledge and expertise, ask questions, build their network and learn about best 
practices for Gigamon products. 

Visit the Gigamon Community site to:

• Find knowledge base articles and documentation

• Ask and answer questions and learn best practices from other members.

• Join special-interest groups to have focused collaboration around a technology, 
use-case, vertical market or beta release

• Take online learning lessons and tutorials to broaden your knowledge of Gigamon 
products.

• Submit and vote on feature enhancements and share product feedback. 
(Customers only)

• Open support tickets (Customers only)
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• Download the latest product updates and documentation (Customers only)

The Gigamon Community is a great way to get answers fast, learn from experts and 
collaborate directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community.gigamon.com 
72   GigaVUE-FM Installation and Upgrade Guide 

https://community.gigamon.com
https://community.gigamon.com

	GigaVUE-FM Installation and Upgrade Guide Version 5.7.00
	Contents
	1 GigaVUE-FM Installation and Upgrade
	2 Install GigaVUE-FM on VMware ESXi
	Before You Install
	Prerequisites for GigaVUE-FM
	VMware ESXi and NSX-V Hardware Requirements
	Supported Browsers

	Install New GigaVUE-FM on VMware ESXi
	Upgrades and OVA Files
	Deploy GigaVUE-FM from an OVA File

	Redeploy GigaVUE-FM Instance (with VMs Already Deployed)
	Initial GigaVUE-FM Configuration
	Use Fault Tolerance for GigaVUE-FM Deployments (VMware ESXi only)
	Perform Initial Configuration
	Add Additional vNIC
	Increase the Memory
	Add vCPUs

	Configure SSH Settings
	HTTP/HTTPS Ports
	Install Third-Party Certificate
	Install Third-Party Certificate on GigaVUE-FM in AWS



	3 Install GigaVUE-FM on MS Hyper-V
	System Requirements
	Windows Server Hardware Requirements
	Supported Browsers

	Install GigaVUE-FM for Microsoft Hyper-V
	Install GigaVUE-FM from an ISO Image File
	Connect and Power On the GigaVUE-FM Virtual Machine

	Initial GigaVUE-FM Configuration
	Configure SSH Settings
	HTTP/HTTPS Ports


	4 Install GigaVUE-FM on KVM
	Limitations
	System Requirements
	Linux Server Hardware Requirements
	Supported Browsers

	Install GigaVUE-FM for KVM
	Install GigaVUE-FM from an ISO Image File
	Initial GigaVUE-FM Configuration
	Configure SSH Settings
	HTTP/HTTPS Ports


	5 Upgrade GigaVUE-FM
	Upgrade an Existing GigaVUE-FM Deployment
	Upgrade from CLI
	CLI Summary of the Upgrade Path

	Upgrade from GigaVUE-FM UI
	Upgrade from External Image Server
	Upgrade with GigaVUE-FM as the Image Server


	How to Use the Snapshot Feature

	6 Additional Sources of Information
	Documentation
	Documentation Feedback
	Contacting Technical Support
	Contacting Sales
	Premium Support

	The Gigamon Community



